SCHEMATIC DESIGN IN QUARTUS

Consider the design of a three-bit prime number detector. Figure 1 shows the block
diagram and truth table. The inputs are binary signals A, B, and C while the output is
binary signal PRIME. Note that this example calls one (001) a prime number for the
purposes of equation simplification. The mathematical definition of a prime number
would not consider one as prime.

| A B C PRIME
0 0 0 0
0 0 1 1
— 0 1 0 1
— PEIME [—— [ 1 1 |
— 1 0 0 0
1 0 1 1
1 1 0 ]
1 1 1 1

Figore 1: A Prime Number Detector

This document will illustrate how to create a Quartus schematic project to draw and
simulate the prime number detector. Students will likely not understand the derived
circuit equations or the schematic diagram early in the quarter when working this
tutorial. Students will learn how to complete the design as the quarter progresses.

Note that your Quartus version may present slight differences in the program title bars,
dialog box titles, option choices, menus choices, etc. The basic windows do not change
from version to version so the original screenshots have been retained for ease of
tutorial document maintenance.
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1. Start Quartus. It will present you with the standard blank startup window.
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2. Create a new project for your circuit design by choosing “New Project Wizard”
from the “File” menu or from the center panel of the startup screen. A project is a
collection of files completing the circuit design. Engineers create design files
during design. Quartus creates additional design files when processing those
created by engineers.

§ e T T

[Fle] edit view Project Assigments Processng Toos window Help 5

0 New.. crln - @q

E Open... crl+0
Close cl+4

S YR D Py S0 ER SR AL O

(8 NewProject Wizard. .

[ OpenProject... ciri+)
Save Project
Close Project

i save ctiss
Save As.

@ saveal Ctrl4shift+s
File Properties.

Create [ Update
Export..

Convert Programming Fies...

Crl+p

Exit Alt+Fd

B Analysis & Synthesss
[ dit Settings

b P Eariy Tming Estimate
b W Fitter (Place &Route)
in, 3

g
meE T <seinr v
3

Type ID Message

jtjﬁ”_’"/\@ﬂ_f

Starts the New Project Wizard 0%  00:00:00

3. Click the “Next” button to advance beyond the information dialog box.

Introduction

The Mew Project Wizard helps you create a new project and preliminary project settings, induding the following:
* Project name and directory

* Name of the top-evel design entity

& Project files and libraries

* Target device family and device

* EDA tool settings

YYou can change the settings for an existing project and specify additional project-wide settings with the Settings command (Assignments menu). You can use
the various pages of the Settings dialog box to add functionality to the project.

[] Don't show me this introduction again

[ <Back | [ mext> ][ Frish |[ cancel ][ Hep |

Page 3



4. Click the "..." button next to the working directory textbox.

Directory, Name, Top-Level Entity [page 1 of 5]

What is the working directory for this project?

C:laltera\13.0sp1
What is the name of this project?

What is the name of the topevel design entity for this project? This name is case sensitive and must exactly match the entity name in the design file.

Use Existing Project Settings...
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5. Create a project folder for your project work.

A. Browse to your Documents folder using the side bar in the file browser.
B. Create a CE1901 folder using the New Folder choice above the side bar.
C. Double-click the CE1901 folder to move inside of it.
D. Create a schematic tutorial folder. This tutorial names the folder as
schem-tutorial.
E. Double-click the schem-tutorial folder to move inside of it.
F. Choose Select Folder.
r“&""ise'e_ft L G S —— =X
@ /u _v| » Libraries » Documents » cel901 » schem-tutorial v|+1»|| Search schem-tutorial pl
Organize * New folder e 7]
B Desktop 5 Name : Date modified Type Size

4 Downloads

%3 Recent Places No items match your search.

] Libraries

m

‘. Documents
4. Music

= Pictures
Q Videos

& Computer
& (C) Local Disk
# () Local Disk

<> (E) RemovableD ~ « 1 3

Folder: schem-tutorial

[ Select Folder l‘ Cancel ‘

Look closely at the screenshot. The instructors recommend you make a CE1901 folder
inside your Documents folder. You will then place project folders inside the CE1901
folder through the rest of the quarter. Good project management is an example of
professionalism.
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Name the project and top-level entity “prime”. Simple projects with a single
functional block — like this one — usually match the project and entity names.
More complicated projects may have different names. Examples of this

type of project will be seen later in the quarter. Click the “Next” button.

&4 New Project Wizard ﬁ

Directory, Name, Top-Level Entity

What is the working directory for this project?

D:/MyDocs/Documents/ce1901/schem-tutorial E
What is the name of this project?

prime E]

What is the name of the top-level design entity for this project? This name is case sensitive and must exactly match the entity
name in the design file.

prime E

Use Existing Project Settings...

<pack || wea> || Emsh || cancel || hep

Page 6



7. Click the “Next” button two more times and arrive at the “Family, Device
Board Settings” dialog box. This dialog box allows you to choose specific Altera
FPGA devices to host your design as hardware components. The DE10-Lite lab
board uses an Altera MAX 10 10M50DAF484C7G. Set the family choice to MAX
10. Choose the specific MAX10 device in the scrollable list of devices. A quick
way to get to this device is to type 10MS50 in the “Name Filter” text box on the
right-hand side and then select the correct one in the “Available Devices” panel.
(h Mew Project Wizard x
Family, Device & Board Settings
Device Board
Select the family and device you want to target for compilation.
You can install additional device support with the Install Devices command on the Tools menu.
To determine the version of the Quartus Prime software in which your target device is supported, refer to the Device Support List webpage.
Device family Show in "Available devices' list
Family: MAX 10 (DA/DF/DC{SA/SC) = Package: Any =
Device: All i Pin count: Any %
Target device Core speed grade: Any i
Auto device selected by the Fitter MName filter: 10M50
’i' Specific device selected in ‘Available devices' list |i} chow advaricad devices
Available devices:
Name Core Voltage LEs Total 1/Os GPIOs Memory Bits Embedded multiplier 9-bit ~
towsoowrasecrc [12v a0 so  leo  hertz e |
| ESRAESOACC anwen aen e 4£7794n  aan s
< Back Finish Cancel Help
8. Click the “Finish” button.
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9. Note the entity file named “prime” in the Project Navigator tab on the left of the
screen. You can open the Project Navigator if it is accidentally closed by
choosing View:Utility Windows:Project Navigator from the menus.

_Bit - Dy e e - o - E-@E
& Quartus 11 64-Bit - D/MyDocs/Documents/ce1901/schem-tutorial/prime - prime 2
File Edit View Project Assignments Processing Tools Window Help Search altera.com | @
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Q Q X =
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No Selection Available
4 vibrary
I» Basic Functions
1> Bitec
> DSP
I» Interface Protocols

JALTERAY

QUARTUSII

Fowe: @ Version 15.0

4 B Comple Design

4 P Analysis & Synthesis
] Edit Settings
8 View Report
> Analysis & Elaboration Buy Software
b P Parti
b [ Netlist Viewers View Quartus I

> P> Design Assistant (Post-M
o b » IIDAssmnmemAna\vs;s Notification Center T

e @ D <<Fiters> A End.. | [ &8 Find Next

Type ID Message

il « »
=\_system /\_Processing /

0% 00:00:00 J‘

Documentation

ETIE

This screenshot also shows the IP Catalog open on the right hand side of the screen.

You can open the IP Catalog if it accidentally closed by using the same process of
selection in the View menu.
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10.

Add the schematic diagram for entity prime.

A. Choose the “new” toolbar icon, the “New...” choice from the “File” menu,

or type ctrl-n. The “New” dialog box will appear.
B. Highlight “Block Diagram/Schematic File”.
C. Click the “OK” button.

o s

MNew Quartus II Project
Design Files
AHDL File
|Block Diagram /Schematic File
EDIF File
Qsys System File
State Machine File
SystemVerilog HOL File
Td Script File
Verilog HOL File
WHOL File
Memary Files
Hexadecimal (Intel-Format) File
Memaory Initialization File
Verification/Debuaging Files
In-System Sources and Probes File
Logic Analyzer Interface File
SignalTap 11 Logic Analyzer File
University Program VWF
Other Files
AHDL Indude File
Block Symbol File
Chain Description File
Synopsys Design Constraints File
Text File

QK i[ Cancel H Help

Schematic diagrams are blueprints of digital computer circuits.
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11.

Click the window “Maximize” button to the left of the
bring the schematic size full-screen.
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Quartus is a Windows application. You will feel quite comfortable with
the menu structure, maximizing, minimizing, saving, and printing.
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12. Double-click inside the schematic grid to call-up the component library symbol

browser.

A. Note that this example has expanded the library to see the basic logic
gates.

B. Note that you can also type the name of the component in the “Name”

textbox to quickly locate it.
C. Select the 2-input OR gate (OR2) to get started building the minimized
equation for function PRIME. Click Ok.

4 Symbol

Libraries:

£ nord -
£ not

£t ori2

i or2:

£t or3

£ ord

£ or6

£ ors i

4 BT b

Name:

or2 (o)

|| Repeat-insert mode

Insert symbaol as block

Boolean Equations for PRIME:

The canonical equation is: PRIME=Xm(1,2,3,5,7)=A’'B'C+A’BC’+A’BC+AB’C+ABC
The minimized equation is: PRIME=A’B+C

You will be able to derive these equations by weeks 3 and 4 of the quarter.
Remember to come back and try to match these equations then!
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13.  Place the OR2 component toward the right-hand side of the schematic by

rolling the mouse into position and clicking the mouse button.

€ Quartus 1T 64-Bit - D/MyDocs/Documents/ce1901/schem-tutorial/prime - prime
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14.

& Quartus II 64-Bif

Place an AND2 component, a NOT component, three input components, and
one output component. Use the name field in the library dialog box to make
finding each component easy. The standard component names are: AND2, input,

output.

it - D/MyDocs/Documents/ce1901/schem-tutorial/prime - prime
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»
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Remember that you can get to the library by "double-clicking” in blank
space on the schematic.
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15.  Wire the components together by clicking and dragging between pins.

€ Quartus IT 64-Bit - Dy/MyDocs/Documents/ce1901/schem-tutorial/prime - prime
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Corners can be made by clicking as you drag the mouse.

Drawing blueprints is fundamental in engineering. It's sort of an art
form! Your blueprint doesn't have to look exactly like the one shown.
Your signal wires might bend earlier or remain straight for that matter.
But, the signal wires and gates must be connected together as shown
in order to guarantee that electricity flows correctly for the design
problem.

Your instructors will evaluate your drawings during the quarter for “visual noise.” In other
words, try to eliminate unnecessary right angles, the number of wires that cross in a
diagram, and keep things like the inputs lined up to create a nice “visual line.”
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16.  Name the inputs and outputs by double-clicking each one and typing its name.
In this diagram, the inputs are names A, B, and C from top to bottom. The single
output is named PRIME.
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17.  Save the completed schematic.

Use CTRL-5S or the "Save” icon. Note that Quartus will present a "Save As"
dialog box in the project folder with a pre-assigned name of "prime".
Just select the "Save” button.
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18. Compile the design to check for errors in wire interconnection. Choose “Start
Compilation” from the “Processing” menu or just click the compile diamond
(arrow) just to the right of the gray stop sign icon.

& Quartus II 64-Bit - D/MyDocs/Documents/ce1901/schem-tutorial/prime - prime =|(E] é}
File Edit View Project Assignments [Processing| Tools Window Help % Search altera.com | @
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Dynamic Synthesis Report

PowerPlay Power Analyzer Tool > B
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Receive Compilation Status Notifications

> U
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BRiiiE

I
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o

Task
4 P> Compile Design
4 P Analysis & Synthesis
[ Edit Settings
B View Report
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[ » < i b # Add
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»

410,46 0% 00:00:00
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9/1/2015

Lots of activity occurs during compilation. Quartus is verifying wire
connections, creating a mapping of technologies used in the design,
fitting the technology mapping to an automatically chosen integrated
circuit chip, creating a programming file for that chip, etc. This process
is known as "silicon compilation" or "compile-place-route” in modern
digital logic design environments. Keep reading the tutorial to see how
you should use the message windows to verify your work.
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19.  Wait patiently while Quartus compiles the design and then verify that the
compile completed successfully.

Carefully check wiring and names if the compiler found errors.

Recompile until you achieve successful compilation.

Note that successful compilation results in a Flow Status: Successful.

Note that the “device” should match 10M50DAF484C7G. Select the

correct chip using menu choice Assignments:Device if it doesn’t match

because the correct chip wasn’t chosen from the New Project Wizard

during project creation.

E. Note that compilation is much faster if the computer is plugged into AC

ooy

& Quartus II 64-Bit - D/MyDocs/Documents/ce1901/schem-tutorial/prime - prime = | E] -
File Edit View Project Assignments Processing Tools Window Help 5 Search altera.com @
DEdd s2a e Y ¥ D Pen 80 w2 e s0>
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C X | [Table X =
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> Cyclone v: SCSEMA4U23C6 prime

prime prime
clos
SCSEMA4U23Cs » Bitec
Final > psp
1/15880(<1%) » Tnterface Protocols
2 > nd Controll
4/314(1%) erals
otal virtual pins 0 > m
Total block memory bits 0/2,764,800 (0% ) @ Search for Partner P
Total DSP Blocks 0/84(0%)
Total HSSIRX PCSs 0

Total HSSIPMA RX
Total HSSITX PCSs
Total HSSI PMA TX Serializers.
Total PLLs 0/5(0%)
Total DLLS 0/4(0%)

Tasks A8 x
T —

Task

ot
> B 10 Assignment Analysis _

3 < Im »

QB G @ ® < Bini. | [Brodven)

Type ID Message

smx| [~

@® 293000 Quartus II Full Compilation was successful. 0 errors, 14 warnings

b

#l
=\ System /\_Processing (127)

602,34 100%  00:01:29

20. Close the compilation report tab by clicking the tab close box (small X) on the
tab.

This finishes the basic steps to drop components into a schematic, wire the components
together, name inputs and outputs, and complete the compilation of the project to verify
connectivity. The next part of the tutorial will explore simulating the circuit to verify
correct operation.
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21.

Choose the University Program verification waveform file (VWF) from the
File:New dialog box. The simulation waveform editor will open.

|

gj New

New Quartus II Project

4 Design Files
AHDL File
Block Diagram/Schematic File
EDIF File
Qsys System File
State Machine File
SystemVerilog HDL File
Tcl Script File
Verilog HDL File
WHDL File

4 Memory Files
Hexadecimal (Intel-Format) File
Memory Initialization File

4 Verification/Debugging Files
In-System Sources and Probes File
Logic Analyzer Interface File
SignalTap II Logic Analyzer File
|University Program VWF

4 Other Files
AHDI Tnclude File

J

»

m

J|

OK Cancel Help

[ —— —— — g b |
&j Simulation Waveform Editor - D:/MyDocs/Documents/cel1901/schem-tutorial/prime - prime - [W... .= (=]
File Edit Wiew Simulation Help & Search altera.com @
R]& & & 4 &)@ )E B EE 2 E 2 2 2 |[F)%
Master Time Bar: 0 ps D E] Pointer: Interval: Start: End:
Value at 0ps 160.0 ns 320.0 ns 480.0 ns 640.0 ns 800.0 ns 960.0 ns -
Name
0 ps 0 ps
4 HIE n | » -
0%  00:00:00 .
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22. Right-click under the “Name” column. Choose “Insert Node or Bus...” from the
“Insert” submenu.

BHEHS O-

FILE HOME = INSERT ~ DESIGN  PAGELAYOUT ~ REFERENCES ~ MAILNGS REVIEW  VIEW Meier, Dr. Russell ~

i Find ~

= Cut i TR T I
Helvetica -|12 -|A A Aa- % “iz-iEr =3 8 1 4aBbCcL AQBDC AaBbCeI AaBbCel AaBbCcD: AaBbC AaBbCCL 4aBbCcL 4aBbCcl AaBbCeL AaBbCcl 71| . Repace
Paste B - 2 a.A- = - - 1 1 =ik
St ¢ rormatpainter B 1 U ek X X v -A-|E o Emphasis  Heading1 T Normal Strong Subtitle Title NoSpac.. SubtleEm.. IntenseE. — Quote  IntenseQu |<| |\ select~
Clipboard = Font = Paragraph = Styles 5 Eding ~

22.  Right-click under the “Name” column. Choose “Insert Node or Bus...” from the
“Insert” submenu.

—
.
€4 simulation Waveform Editor - D:/MyDocs/Documents/ce1901/schem-tutorial/prime - prime - [W... L=/ =] =
File Edt View Simulation Help Search altera.com | @
[Bax e~ &30 B e |2 x84
Master Time Bar: 0 ps E E Pointer: 5.39 ns Interval: 5.39 ns Start: End:
Valueat |[0PS  1600ms  3200ns  480.0ns  6400ns  8000ns  960.0ns 4
e : ! . ! : :
0ps 0ps
K Delete Del
Insert Node or Bus...
Grouping > nnection:
Reverse Group o Bus Bit Order lde Finder
Radix »
S Properties..
< SIE i T
Insert a new node or bus 0% 00:00:00

B B -————h——+ 100%

PAGE20 OF25 1449 WORDS [I%

— - 1l = T
2 06 O o= a6

23.  Click the “Node Finder...” button. Quartus calls all pins and gate connections
nodes. Thus, all electrical signals are nodes in the circuit. The Node Finder

Dialog box will open.

gj Mode Finder

Mamed: * Filter: |Pins: al v] I QK I
Lookin: = E l List l [ Cancel ]
Modes Found: Selected Nodes:

NaT'ne Type NaT'ne Type
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24.  Select signals for viewing on the electrical simulation.

A. Click the List button.

B. Highlight all the pins in the left panel and copy them to the right panel —
the “selected nodes” panel — by using the copy button “>”. This chooses all
the pins as signals of interest for the simulation.

Click the OK button to close the dialog box.

Click the OK button to close the second dialog box.

Note that the waveform workspace panel will now show the circuit
signals with no energy on them. Signal PRIME is shown with

‘unknown” voltage because it is an output and the simulation has not yet
been executed.

mo o

tor - Dy/MyDocs/Documents/ce1901/schem-tutorial/prime - prime - Waveform.ywf]*

Help o
&t Z XEE BB R R A

Master Time Bar: 0 ps <[ er
U TouU s

ups
Valueat | ips
0ps

Interval: 455.34 ns Start: End

B0

B0

Name
A
B
(e

B0

PRIME  BX LR CEESEE SR SEEE S EEEE CECEEELEEEEEEEEEEEE S ErE e S e

Errly

0%  00:00:00

The "Mame" sub-panel can be “pulled” to the right using the mouse so
that the entire "prime” signal name can be read.
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25.  Group the input bits into a 3-bit binary number.

Arrange the signals so that A is at the top of the inputs, B follows, and C
is the last input bit. The signals may already be correctly ordered.
Highlight signals A, B, and C using the Shift Key and mouse clicks.
Right-click on the signal set.

Choose Group from the Grouping submenu.

Note that grouping allows you to write binary numbers onto the signal
group. This is just like signals sitting side-by-side in a truth table.

Name the group ABC when asked. Because A is the top signal, it is the
most-significant bit and C is the least-significant bit in the group.

G. Set the radix to Unsigned Decimal.

H. Click Ok to close the group dialog box.

>

moow

m

& simulation Waveform Ediitor - D/MyDocs/Documents/ce1901/schem-tutorial/prime - prime - [Waveform.ywf]* [ S
File Edit View Simulation Help Search altera.com | @
[ &0 m Z X EBEB L E 2 a2

< | [ » | Pointer: s10.77ns
TouU s 30,071S

| ®

out ARG SO E P LGOS G EE OO EC O C G LrC OO CC eSOt e R e e e O S e e e e
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26. Overwrite a counting sequence onto the ABC signal group.

A. Highlight the ABC group by clicking its name in the name column.

B. Choose the counting sequence icon from the tool bar. It has a C on it!

C. Note that the simulation window shows 1000 nanoseconds of time. Three
binary input signals encode the numbers 0 through 7 for a total of
eight possible numbers. Good simulation practice would examine the
PRIMEcresult for each of these possible inputs exactly once. Thus, 1000
ns divided by 8 possible input patterns gives 125 ns of time per input

pattern.

D. Set the Count Every entry box to 125 ns. Read item c above for an
explanation of this number.

E. Click the OK button.
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27. Choose Run Functional Simulation from the Simulation Menu.
A. Accept the default waveform filename.
B. Significant work will appear on your screen as Quartus simulates.
C. View the simulation results! Decimal 1, 2, 3, 5, and 7 are prime and
thus the gate circuit drives energy onto the PRIME signal for only
those values.

&4 Simulation Waveform Editor - D:/MyDocs/Documents/ce1901/schem-tutorial/prime - prime - [prime_20150901105545.sim.vwf (Read-Only)] {':' = ﬁ
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28. Close the simulator by clicking the close (X) icons in the simulator waveform
editor and results windows.

29. Close the Quartus project by choosing Close Project from the Quartus File
menu.

This concludes the Quartus schematic and simulation tutorial. Quit Quartus using by
choosing Exit from the File menu.
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